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Introduction
Engineers face the challenges of making RF or uW measurements in 
noisy environments and analyzing significant amounts of measurement 
data to determine its causes. An application note titled Agilent Modular 
Products M9392A PXI Vector Signal Analyzer System with Streaming 
Capability (literature number 5990-8872EN) outlines a test methodology 
and hardware and software configurations to stream and capture data to 
perform specific analyses to determine the causes of RF interference. 

This white paper provides detailed step-by-step instructions and a  
demonstration example to enable engineers to create a multichannel  
100 MHz wideband signal analyzer streaming solution. Streaming is a 
generic term that is used to identify real-time throughput of data into 
a device or out of a device. This document covers the use of an RF 
receiver to stream data to final storage (or RAM). Though it is possible 
to playback data real-time from an RF source, this topic is not covered 
in this document. In this paper, data playback is achieved through the 
following software applications used to read and playback a previously 
stored recording:

•	 Agilent 89600 VSA software 
•	 X-Com Systems Spectro-X and Dataviewer

This paper also describes ways to make “gapless recordings” of 
streamed data from a receiver to final storage, single hard disk or RAID 
so that no data meeting measurement requirements will be lost.

Abstract 
The Agilent M9392A PXI 
Microwave Vector Signal Analyzer,  
together with the hardware and 
software configurations described 
in this white paper, provide a 
streaming and recording capability  
on two or more synchronized  
channels of 100 MHz wideband 
RF environment. The white paper 
provides detailed step-by-step 
instructions for creating a  
streaming solution including:

▪ 	Hardware configurations
▪ 	Software applications
▪ 	89600 VSA software for data 

analysis
▪ 	Demonstration example for  

setting up multichannel  
streaming

Challenge the Boundaries of Test ...
                        ... Agilent Modular Products



2

Applications
The 2-channel PXI Vector Signal Analyzer (VSA) based on the Agilent M9392A 
provides the flexibility required for general RF testing. The 100 MHz bandwidth 
on two channels is useful for field testing on the latest RF devices.

RF interference testing is a primary application for the 2-channel VSA, as it is 
easy to configure a measurement that records data on two adjacent channels. 
Targeted streaming acquisitions can be made on a second digitizer based on 
data from the primary digitizer in continuous normal acquisition mode. The 
recording session on the second digitizer is triggered after a conditional analysis 
of data on the other channel.

The solution described proposed in this document is superior to traditional methods  
used to determine the causes of RF interference. It maximizes the possibility of 
recording the “target event” and reduces time spent analyzing data.

Please refer to the following documents which provide information about  
streaming applications:

•	 Interference Detection in Wireless Devices (literature no. 5990-9965EN)

•	 Single Channel Streaming with the M9392A (literature no. 5990-8872EN)

•	 Configuring the JMR RAID with the M9392A (literature no. 5990-9483EN)
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1.	  
Software Installation 
Instructions

This section lists the software required to control the various modules and 
provides step-by-step instructions for its installation. 

The table below provides a list of software and the URL where the software can 
be downloaded.

For PXI LO, 2-channel M9392A, independent LO’s

Software Download location
M9018A chassis drivers www.agilent.com/find/M9018A
Agilent IO Libs 16.1 http://www.home.agilent.com/agilent/product.

jspx?cc=US&lc=eng&ckey=1985909&nid=-
33330.977662.00&id=1985909&cmpid=zzfindiosuite

M9392A drivers, version 1.3.0 www.agilent.com/find/m9392a
M9381A drivers (M9300A 
Frequency Reference driver 
required, other module drivers 
optional). Choose custom 
installation in the M938x 
software installer. 

www.agilent.com/find/m9381a

89600 VSA (Optional) www.agilent.com/find/vsa
Multichannel streaming 
demonstration example

http://www.home.agilent.com/agilent/facet.jspx?
t=80045.k.1&cc=US&lc=eng&sm=g
Look for multichannel streaming example program

Install these software packages in the order listed, following prompts for reboot 
whenever requested.

After all software has been installed, reboot the system, and run Agilent  
Connection Expert to verify that all modules enumerate with a VISA resource 
ID, and that each module appears with the correct slot number identified on the 
information pane on the right when you click on each module.

The M9300A Frequency Reference module provides a 100 MHz clock to the 
M9202A digitizers when the M9302A Local Oscillator is not used.

Multichannel Wideband Streaming with PXI M9392A

http://www.agilent.com/find/M9018A
http://www.home.agilent.com/agilent/product.jspx?cc=US&lc=eng&ckey=1985909&nid=-33330.977662.00&id=1985909&cmpid=zzfindiosuite
http://www.home.agilent.com/agilent/product.jspx?cc=US&lc=eng&ckey=1985909&nid=-33330.977662.00&id=1985909&cmpid=zzfindiosuite
http://www.home.agilent.com/agilent/product.jspx?cc=US&lc=eng&ckey=1985909&nid=-33330.977662.00&id=1985909&cmpid=zzfindiosuite
http://www.agilent.com/find/m9381a
http://www.agilent.com/find/vsa
http://www.home.agilent.com/agilent/facet.jspx?t=80045.k.1&cc=US&lc=eng&sm=g
http://www.home.agilent.com/agilent/facet.jspx?t=80045.k.1&cc=US&lc=eng&sm=g
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2.  
Hardware 
Configurations

M9202A trigger setups
M9202A multichannel setups are synchronized via distribution of a trigger out 
from the master digitizer to the trigger input of all digitizers. Synchronization 
performance of the multichannel VSA is ± 2 samples of trigger uncertainty from 
acquisition to acquisition. This means the operation is not phase coherent but 
still adequate for MIMO PHY-layer EVM measurements. At full data rate, or  
2 GSa/s, ± 2 samples of trigger uncertainty is based on the output sample rate. 
For example, at 100 MHz bandwidth (BW), 125 MSa/s is used, equating to a 
trigger uncertainty of ± 16 ns between channels which cannot be calibrated out. 

There are three primary trigger modes: free run, IF magnitude, and external.  
The following table describes the conditions for which the various trigger modes 
are valid. 

Mode Single channel input Multichannel input
Free run  
(software trigger)

Auto-trigger Auto-trigger 
(unsynchronized acquisition)

IF magnitude Master input 1 Master input 1
External Master TRG 1 Master TRG 2

There is no software trigger mode synchronization for multichannel operation. 
Therefore, free run with a multichannel system will result in unsynchronized 
results. It is necessary to use either external or IF magnitude trigger modes for 
synchronized operation, which is required for multichannel streaming.

In IF magnitude trigger mode, the master digitizer triggers on the input signal 
into input 1 connector. It is an envelope edge trigger, and not a level trigger.  
The master digitizer outputs a trigger output pulse of amplitude approximately  
0 to -1 V. This must be routed into all digitizers’ TRG 1 inputs including the 
master digitizer’s input.1

In external trigger mode, the master digitizer triggers on the TRG 2 input. The 
master digitizer outputs a trigger output pulse of amplitude approximately 0 to  
-1 V. This must be routed into the slave digitizers’ TRG 1 inputs. It is not neces-
sary to route the signal into the master digitizer’s TRG 1 input, but doing so will 
not impair performance. In both cases above, it is necessary to set the trigger 
input threshold for the TRG 1 input to a negative voltage around -0.5 V.

1. 	 This mode is only available when using hardware DDC. In basic digitizer mode, only external 
trigger mode is available. When using the streaming capability the hardware DDC is also 
required. This means that the digitizer IF must be nominally set to 500 MHz IF but can be offset 
by some cardinal values which depend on which decimation stages have been used. For a 
bandwidth of 100 MHz the digitizer will be sampling at 125 MSa/s. In this case it is possible to 
offset the IF center frequency by ± 125 MSa/2 or 62.5 MHz. See Section 8, Offsetting Digitizer 
DDC Frequencies.
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Also note that there will be some inherent delay between the master and slave 
digitizers, as well as an inherent delay from trigger arrival at the master to signal 
acquisition. Some effort is made in the software to correct for this since in 
master/slave trigger synchronized mode the master/slave delay is always less 
than ± 2 samples (at DDC sample rate) in multichannel streaming mode.

When streaming acquisitions are made, each channel recording has a separate 
header file which indicates the settings under which the recording was made. 
One of these settings, XStart records the time when the trigger event occurred. 

2-channel streaming with M9392A and M9302A PXI local oscillator 
or external local oscillator
A 2-channel streaming solution with independent local oscillator (LO) tuning 
provides the most flexibility for RF environment testing, as the 100 MHz stream-
ing channels can be configured in various ways.1,2 Data can be recorded on 
two synchronized channels simultaneously at any frequency supported by the 
M9392A. In master/slave triggering mode, the acquisition on both channels can 
be synchronized to within ± 2 digitizer samples.

1. 	 When using two M9392A Vector Signal Analyzers, 100 MHz streaming is only supported above 
2.25 GHz since the M9351A RF Downconverter only supports 40 MHz bandwidth.

2. 	 When using the M9360A preselector path in high band above 2.75 GHz the YIG tuned filter has 
a maximum bandwidth of 40 MHz. 

The diagram at right shows the trigger 
connections for a 2-channel configuration. 
This setup will work for both IF magnitude 
and external trigger modes.

2-channel PXI local oscillator, 
independent local oscillators

Splitter 

External 
Trigger 

100 MHz 
Ref 

Master 
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2-channel cabling, PXI LO, independent LO’s

4-channel streaming: two chassis, each with two channels
The 89600 VSA software supports 4-channel configurations, but configurations 
of more than four channels can be created. 4 x 100 MHz simultaneous streaming  
channels can be created with two complete 2-channel VSA streaming solutions.

When using two or more chassis’, it may be necessary to use two PCI express 
extender cards with a desktop controller to connect both chassis.

Software support for M9362A-D01, M9352A, M9168C and external LO
Support for M9362A-D01 4-channel downconverter, M9352A 4-channel IF 
amplifier/attenuator and the M9168C RF attenuator are included in v2.0 of the 
multichannel streaming example program. This hardware will be coupled to the 
M9202A + Other hardware configuration in the multichannel streaming example 
program. External LO support using an MXG has also been provided. A number 
of IVI configuration names will be loaded from an external configuration file. 

2-channel block diagram, PXI LO, 
independent LO’s
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Hardware configurations supported in v1.0 & v2.0 of the 
demonstration example described in Section 8

Hardware module/PC card # of 
slots

Default IVI 
storage 
name

Function

M9392A analyzer configured 
as master trigger instrument

8 MasterVSA uW vector signal analyzer

M9392A analyzer configured 
as a slave, to be triggered by 
the master

8 SlaveVSA uW vector signal analyzer

M9392A digitizer only 
configured as master trigger 
instrument

1 MasterDigit Digitizer only vector signal 
analyzer. User provides 
software control of RF HW

M9392A digitizer only 
configured as a slave, to be 
triggered by the master

1 SlaveVSA Digitizer only vector signal 
analyzer. User provides 
software control of RF HW

Hardware configurations supported in v2.0

Hardware module/PC card # of 
slots

Default IVI 
storage 
name

Function

M9168C 100 dB RF attenuator 2 RFAttenCh1 Channel 1 RF attenuation for 
M9362A-D01 quad

M9168C 100 dB RF attenuator 2 RFAttenCh2 Channel 2 RF attenuation for 
M9362A-D01 quad

M9362A-D01 quad 
downconverter

3 QuadDConv 4 channel RF downconverter

M9352A quad IF amp/atten 1 QuadIF 4 channel IF amp/atten
M9300A frequency reference 1 Ref Replaces PXI LO when using 

an external LO
MXG (LO) n/a MXGLO Provides LO for M9362A-D01

The additional hardware is required when using the M9202A + Other Hardware 
mode in the demonstration program. It is controlled by a text configuration file 
found in the program/bin folder. For clarity, the example shows the full PXI 
names for some of the external modules instead of the alias names. 
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Hardware configurations being considered for future releases

Hardware module/PC card # of 
slots

Default IVI 
storage 
name

Function

M9155C dual uW switch 1 uWSwitch1 Provides signal mux capability 
for preamp

Symmetricom bc637PCI-V2 
IRIG/GPS

1 [PC 
slot]

SymTime Adds time stamping

M9405A 1 PreAmp 26.5 GHz 30 dB preamp

Using these IVI configuration names for your own defaults will map to the 
default IVI configuration names in the example software.

For information on configuring a Wideband Multichannel System for MIMO 
Applications, please see literature no. 5991-0135EN. 

Potential M9202A digitizer firmware upgrades
If upgrading an existing system for multichannel, the M9202A digitizer firmware 
needs to be at version 512 or greater. Documentation describing the upgrade 
process can be found in the M9392A help system. To check the firmware version 
number, use the soft front panels (SFP) for the MD1 or the M9392A. To check 
using the M9392A SFP, connect to the digitizer then select Help→About. On the 
about screen, the digitizer hardware FPGA version will be displayed. If a version 
less than 512 is displayed, follow the instructions in the M9392A documentation 
to upgrade to version 512. Check this for each digitizer in the configuration. 
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M9300A frequency reference
When an external LO is used, the M9300A is placed in the timing and  
synchronization slot 10 in an Agilent M9018A chassis. The M9300A is required 
to provide a 100 MHz clock for each of the M9202A digitizers. In a future soft-
ware release this module will be enabled for trigger distribution to provide its 
own software issued trigger for cases when we would like to completely control 
M9392A acquisition.

The M9300A SFP can be used to enable 
the 100 MHz reference output, and 
configure 10 MHz reference input and 
output.
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Splitter 

External 
Trigger 

100 MHz 
Ref 

Master 

DC BLOCK 

Using a software generated trigger to Initiate a streaming acquisition
The M9300A module can be used to issue a software trigger via the API. Any 
instrumentation used in the measurement system that can issue a software  
trigger under programmatic control can be used in this recording mode. 

When issuing a software programmable trigger to start a streaming session the 
recording channel itself can be triggered from either an external trigger event or 
a signal magnitude threshold (video trigger).

An external trigger is connected to the Trg1 input. The magnitude trigger is 
generated in the DDC hardware chain beginning at the digitizer RF connector. 
Section 8 on Offsetting Digitizer DDC Frequencies provides more details.

An alternative hardware configuration is required (pictured below) when one 
channel is used to monitor data and the other is used to record data. In this 
configuration, a DC block is used to issue triggers to the second digitizer. 
The master digitizer is used to acquire data and issue a trigger to the second 
digitizer based on data analysis by the VSA 89600 SW. This configuration is not 
compatible with the other configurations described above. The DC block should 
be removed when operation does not require the master digitizer in normal 
acquisition mode to provide triggers to the second digitizer. 

The term trigger digitizer is used here in the sense that the data acquired by  
this digitizer is used to conditionally trigger a recording on another channel 
by programming an instrument to generate the software controlled trigger. An 
Agilent signal source can be programmed to perform this task. In situations 
where a software controlled trigger is not available an M9300A reference 
module can be used.

M9300A PXIe Frequency Reference



12

Symmetricom model 
bc637PCI-V2 module 
shown is a GPS 
synchronized, PCI time & 
frequency processor from 
Symmetricom Systems.

Timing, synchronization and GPS positioning
If an inter-range instrument group (IRIG)/GPS capability is required then a  
module, such as the Symmetricom model bc637PCI-V2 can be added to the  
Dell T5500 workstation. The Symmetricom time and frequency processor has a 
port that accepts triggers or other external events. In the case of a 2-channel 
streaming solution the trigger event that starts a recording can also be used to 
trigger this module to obtain accurate time and position information. 
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RAID storage (optional)
RAID storage is required for any full bandwidth streaming captures of more than 
a few seconds. For narrow band captures greater than 10 MHz bandwidth and 
very long durations, a RAID is also recommended. At wider bandwidths data 
acquisition occurs at a much faster rate than can be moved to final storage, 
particularly if final storage is a single hard disk drive. The RAM allocated for the 
acquisition is filled up faster than it can write out to disk which presents a risk 
of losing or overwriting data.

When a RAID is used to write out multiple streams of data, it is a good practice 
to write each stream out to a separate virtual drive, each with its own controller. 
This maximizes throughput of each stream because the data storage does not 
have to deal with any contention issues. Agilent references a number of pre-
configured JMR RAID storage systems. When storing 2 x 100 MHz simultaneous 
streams the dual controller RAID system is recommended. Each internal control-
ler has half of the available disk array allocated to it. This means that on a typi-
cal computer system (the Dell T5500 is recommended) one controller will appear 
as Volume E and the other as Volume F. Recommended dual channel controller 
JMR RAID options for this purpose are AGIL-4G-DC-16T and AGIL-4G-DC-32T. 

Single channel streaming data flow

The figure at right illustrates the data 
flow for a dual channel RAID controller. 
Each controller presents a unique 
volume to the user.
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3. 
Applications with  
M9300A Frequency 
Reference Module

Having a flexible 2-channel system presents a number of interesting operating 
modes. In addition to fully synchronized 2-channel recordings, another useful 
feature of this system is to use one channel to trigger a recording on the second 
channel after performing analysis on the data from the RF environment. In cases 
where the engineer has narrowed down to a short list of intermittent interfering  
signals that could be affecting a new RF device, it is possible to acquire data 
normally on one channel, perform targeted analysis on this data and then 
decide based on an analysis of this data whether to trigger a recording on the 
other channel. The analysis does not have to be completed in real time, as the 
recording channel can be configured to acquire an exact amount of pre-triggered 
data. For example, if it takes two seconds to perform the required analysis on 
the trigger channel data, the recording channel can be setup to capture more 
than two seconds worth of pre-trigger data, so the event of interest will not be 
missed. This useful feature allows the engineer to go beyond simple frequency 
mask triggering. For each second of pre-trigger data at 100 MHz bandwidth.  
500 MB of controller RAM will be required.

Pseudo-code for signal analysis triggerPage 11 

Recording Channel Analysis Channel

Trigger event
Pre-Triggerred Data

External Trigger Video trigger /
External Trigger

Controller RAM
Buffer

Acquire some data

Process Data
Process time must be less
than pre-trigger record time

?Y N

The External trigger can come form any piece of instrumentation
that can provide a program controlled trigger out

Psuedo Code for Signal Analysis Trigger

Loop (!exit)

Acquire Data On Trigger Channel
Analyze Trigger Channel Data
Issue_Trigger (T/F)

IF(!Recording && Issue_Trigger)
Trigger Recording ?

IF(Recording && Issue_Stop)
Stop Recording? [Duration Unlimited Mode Only]

IF (Issue_Trigger)
Set Recording Channel Trigger Mode
Set Recording Channel Pre-trigger Time
Set Streaming Mode [ Duration Limited or Duration Unlimited]

IF (Duration_Limited)
{
Set Recording Time
Start Streaming For Recording Time
Update Streaming Status [every 1 second]
}

IF (Duration Unlimited)
{
Start Streaming
WHILE(!Stop_Recording)

Update Streaming Status [every 1 second]

Stop Recording
}

End Loop

 

The figure at right illustrates how the 
signal analysis trigger mode works.
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Loop (!exit)

	 Acquire Data On Trigger Channel
	 Analyze Trigger Channel Data
	 Issue_Trigger (T/F)

	 IF(!Recording && Issue_Trigger)
		  Trigger Recording ?

	 IF(Recording && Issue_Stop)
		  Stop Recording? [Duration Unlimited Mode Only]

IF (Issue_Trigger)
	 Set Recording Channel Trigger Mode
	 Set Recording Channel Pre-trigger Time
	 Set Streaming Mode [ Duration Limited or Duration 
Unlimited]

	 IF (Duration_Limited)
		  {
		  Set Recording Time
		  Start Streaming For Recording Time
		  Update Streaming Status [every 1 second]
		  }

	 IF (Duration Unlimited)
		  {
	 Start Streaming
	 WHILE(!Stop_Recording)
			   Update Streaming Status [every 1 second]

		  Stop Recording
		  }

End Loop
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4. 
Applications with  
Symmetricom Timing, 
Synchronization & GPS 
Positioning Card

Using a Symmetricom IRIG/GPS timing card with a 2-channel M9392A streaming  
solution allows the engineer to trigger a recording and map the trigger point 
in the streaming data to an absolute time stamp and position coordinates. The 
diagram below illustrates how the trigger channel works with the digitizer in 
normal acquisition mode to search for specific data. Continuous acquisitions 
are made until a significant event is detected. The event can be a signal at 
a specific frequency or level or it can be a particular burst characteristic or 
communications standard. The data from the trigger channel is continuously 
monitored. Software, such as the 89600 VSA software, can analyze the data and 
determine whether the current data meets the required criteria. If the necessary 
criteria are met then the PC controller can be set up to issue an external trigger 
to begin a recording.

The software controlled trigger can be issued for a signal source, for the 
M9300A frequency reference or any other piece of hardware that can generate 
a trigger signal from a software event. In theory, it would be quite easy to create 
a long term data sampling system to acquire a few minutes’ worth of streaming 
data to a RAID every few hours. For each streaming acquisition, a header file 
is created that describes and records when each trigger event occurred. The 
Symmetricom timing card could be configured to output a time stamp each time 
it received the same trigger to mark the absolute time for any of the streaming 
record samples.

In the figure below, a 10 minute streaming 
acquisition is made every three hours over 
a period about two weeks. This setup 
could be very useful for tracking telemetry 
data over long periods of time.
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A more detailed view of streaming with IRIG/GPS time stamping. The figure 
below shows 2-channel M9392A with IRIG/GPS time stamping correlated to 
trigger time in the recording.Page 13 

Issue Trigger
Generated from any instrument that
supports software initiated trigger

External Trigger or
Magnitude Trigger

Recording Channel

Trigger event
Pre-Triggerred Data

Controller RAM
Buffer

Trigger IRIG/GPS Card
Time: 12:00:00:000 AM

Position: 38.483241, -122.711599; Alt
800 ft

Give Trigger
point in Stream

an absolute
time / position

Reference

The trigger point in a streaming record is marked as the time
from the start of the record.

This time is marked by XStart from the header file
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5. 
Using the M9392A 
SFP to Set Up 
Multichannel Hardware 
Configurations

6. 
Data Analysis with 
89600 VSA Software 
for Multichannel 
Streaming

This section covers the use the M9392A Soft Front Panel (SFP) to control mod-
ules and create IVI configurations. Also included in this section, is an explana-
tion of the M9392A streaming implementation, memory and final storage details.
The SFP for the M9392A does not support multichannel streaming. However, 
the multichannel demonstration program adds multichannel support for the API 
including input extensions for the 89600 VSA software.

Please note that the M9392A API must be running on a 64 bit operating system 
to implement multichannel streaming. In a multichannel configuration, the 
M9392A SFP is used primarily to configure and control a complete M9392A 
signal analyzer or a single M9202A digitizer in digitizer only mode. It is used to 
create and export IVI configurations which can be programmatically accessed 
by other software, such as the multichannel streaming demonstration example 
program or the 89600 VSA software.

Please refer to the M9392A documentation for details on selecting modules and 
creating other configurations.

This section covers configuring and using the 89600 VSA software to playback 
multichannel streaming records from the dual channel PXI vector signal analyzer 
(VSA). Please be aware that the streaming interface for the M9392A cannot be 
activated from the 89600 VSA software. For multichannel streaming, hardware 
control is only available via the M9392A API interface which supports IVI COM. 
While streaming acquisition cannot be accomplished using the 89600 VSA 
software, it can be used for analysis of M9392A recordings. The 89600 VSA soft-
ware provides the user a convenient way to playback previously recorded data. 
Both single channel and dual channel streaming records can be played back and 
thoroughly analyzed using this software.

Dual M9392A, dual M9392A digitizer only
For playback of dual M9392A streaming records, a 2-channel configuration will 
need to be made using the 89600 VSA hardware configuration tool. In order to 
create a dual channel configuration the engineer must first identify the hardware  
and then create an IVI configuration for each M9392A streaming analyzer.

Step 1. Creating an IVI configuration store entry
Create an IVI configuration store entry for each channel. When using two 
complete M9392A’s, follow the same process outlined below for M9392A 
digitizer only mode, except you will select all modules required for the M9392A 
configuration. If using the M9392A software with digitizer only mode, create an 
IVI configuration store entry for each of the digitizers through the M9392A SFP. 
Upon launching the M9392A SFP, a dialog will appear prompting you to select 
your hardware. Any modules recognized by the M9392A software will appear. 

The following example illustrates how to create a dual channel M9202A digitizer 
only configuration. For synchronized multichannel operation, you will need to 
designate one of your digitizers as master, and the remaining as slaves. It helps 
to pick a convention, such as master on left, slave 1 in the next slot to the right, 
slave 2 to the right of slave 1, etc. Note, 2 x full M9392A VSA’s could have also 
been used.
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1. 	Use the Agilent Connection Expert tool to identify the M9202A digitizer in the 
left-most slot.

2. 	Next start the M9392A SFP, and choose only the M9202A digitizer with this 
resource ID.

Note the VISA Resource ID 
(something like PXI17::12::0::INSTR).
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3. 	Press connect, and wait for hardware initialization to complete. Choose 
File→Save Connection.

4. 	On the dialog that appears, give the configuration a recognizable name, 
avoiding spaces and underscore (_) characters. Enter a description in the 
description field, and be sure to check the export to Agilent 89600 VSA 
checkbox before pressing the save button.

5. 	Choose the File→Connect menu, and connect to the first slave digitizer, save a 
configuration for this digitizer, and repeat for all channels in your configuration.

Step 2. Creating an 89600 VSA hardware configuration
Start the VSA software or restart it to rediscover hardware. This will allow it 
to recognize the new IVI configuration store entries that were exported in the 
previous step.

1. 	On the Utilities→Hardware dialog in the VSA software, click on the discovered  
instruments tab. The configurations you just added will be present in the 
under the TCPIP tree element.
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2. 	Switch back to the configurations tab, and create a new configuration by 
pressing the button with the green + symbol.

3. 	Add one Agilent M9392A analyzer connection per channel to the  
configuration box by pressing the right-arrow button.

4. 	Select the master digitizer configuration you created for the top most entry in 
the configuration box by choosing it from the drop-down list labeled analog 
to digital(ADC).

5. 	Repeat this for the slave digitizers. It is important that the master digitizer be 
associated with the topmost entry for synchronized operation.

6. 	Now you are ready to start using your hardware. Give the configuration a 
name and press OK.

7. 	On the hardware dialog, choose the newly created configuration from the 
current analyzer configuration list box and wait for the hardware to initialize.
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Step 3. Operation
Adjust trigger delay and channel to channel skew. Trigger delay for all channels 
can be adjusted by using the delay setting on the Input→Trigger dialog. To 
adjust the channel to channel skew between the master and all slave channels, 
a new parameter has been added to Input→Extensions: SlaveTriggerSkew.1  
The following goes into more detail on trigger delays and slave trigger skew.

By default, after selecting a multichannel PXI VSA hardware configuration, 
only one input channel will be enabled. To enable more channels, use the 
Input→Channels menu, or by loading a setup that is configured for multichannel.

In digitizer only mode, the spectrum may be inverted, depending on whether you 
are using high-side or low-side LO. If you are using high-side LO, you should use 
the VSA software’s mirror spectrum capability. Once the trigger levels and other 
settings are complete, you can start to make measurements. Set your center fre-
quency to the IF center frequency (nominally 500 MHz for DDC operation), and 
your bandwidth. Note, with the current version 14.2 of the 89600 VSA software, 
the spans must be set the same value for all channels.

1. 	 These settings only operate when connected to real hardware. The settings will not be applied 
when playing back a recording.
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New trigger delay and slave trigger level input extensions
Trigger delay for all channels can be adjusted by using the delay setting on the  
Input→Trigger dialog. To adjust the channel to channel skew between the master  
and all slave channels, a new parameter has been added to Input→Extensions: 
SlaveTriggerSkew. Enter the number of seconds to move the slave trigger point 
relative to the master digitizer. The following illustrates this.

The trigger level setting on the Input→Trigger dialog will set the trigger input 
threshold for the master digitizer’s input, either on the signal input, or on the 
trigger input (TRG 1 for single channel, TRG 2 for multichannel). The default 
slave sync trigger level will be set to -0.5 V. This is fine for dual channel  
streaming mode.
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Playback streaming waveforms
This section describes how to load a recording into the 89600 VSA software. 
There are two main recording formats that are commonly used for playing back 
M9392A streamed data: binary format and dual channel tabulated text format

Binary format
The binary format within the 89600 VSA software is called N5110A. This is the 
exact same format used by the M9392A. To playback a recording, on the 89600 
VSA GUI:

1. 	Select File→Recall→Recall Recording.

2. 	Browse to find an appropriate binary steaming file and then select the  
binary format as N5110A Waveform (*.bin), then open the file. You must  
have configured appropriate hardware, one or two M9392A instruments, as 
discussed previously. Even though the physical hardware does not need to  
be connected to playback the waveform, a valid IVI configuration is still 
required. The streaming header file will allow the 89600 VSA software to 
set the correct center frequency, bandwidth (span in 89600) and amplitude 
scaling.

	 Since you are manipulating 
a recording you need to 
use the playback trigger.
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It is also useful to turn on the player bar that allows you to control the playback 
of the recording. In the figure below, the player is shown underneath the graph 
windows.

Once you are displaying useful information and are happy with your measure-
ment, it is good practice to save the setup using File→Save→Save Setup.

The single channel binary streaming format N5110A is the most convenient  
for single channel measurements since it is the native format for the M9392A 
PXI VSA.

Playback on M9381A PXIe vector signal generator
The M9381A PXIe VSG has 4 GB of RAM which can hold 1 GSa of ARB data.  
At 125 Msa/s at 100 MHz bandwidth, the M9381A can collect 8 seconds of 
wideband signal playback. A Visual Studio based windows tool is available to 
load previously recorded data into an M9381A for playback. To request this tool, 
please contact SMS Technical Support. 
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M9202A hardware DDC operation
The M9202A digitizer, when used with the M9392A software, takes advantage 
of hardware DDC in the digitizer’s FPGA under certain conditions. The DDC 
allows for data reduction, which results in faster throughput and reduced cap-
ture sizes, which increases the maximum length of a capture by more efficiently 
utilizing the digitizer’s memory. It also improves signal to noise ratio, resulting in 
improved residual error vector magnitude (EVM), among other effects.

The hardware DDC is enabled under a limited set of conditions. When the  
hardware DDC is not enabled, a software DDC is used instead which affords 
some benefits, though the digital memory efficiency is not realized since 
captures in this mode are stored to digitizer memory as real, full sample rate 
data and the software DDC is performed in the controller by the M9392A driver. 
Streaming does not operate under the software DDC. The table below describes 
the conditions under which hardware DDC is available for both complete 
M9392A, including simulated LO and downconverter modes, as well as digitizer 
only modes.

Complete M9392A and digitizer only M9392A
In this mode, hardware DDC is almost always used, as the IF center frequencies 
and bandwidth are chosen by the M9392A driver to ensure hardware DDC oper-
ation. The only exception is through the use of an IF offset hint. The hint usage 
is documented in the M9392A software, and is available through the M9392A 
IVI API as well as exposed in the input extensions interface in the 89600 VSA 
software. When an IF offset (other than 0) is used, you may encounter a mixed 
mode DDC, in which the following conditions apply:

•	 Hardware DDC decimates down to 2x the final bandwidth and sample rate

•	 The M9392A driver applies a frequency shift to the final IF offset

•	 Software DDC in the M9392A driver does a final decimation by a factor of 2

Note that pure hardware DDC may still be available under a specific set of con-
ditions: if the entire IF span is contained between 375 and 625 MHz, and if the IF 
center frequency chosen is on a cardinal frequency, as defined in the following 
table.

Bandwidth (MHz) Valid IF center frequency for HW DDC (MHz)
250 500
125 500
62.5 437.5, 500, 562.5 (previous row ± 62.5)
31.25 406.25, 437.5, 468.75, 500, 531.25, 562.5, 593.75 

(previous row ± 31.25)
15.625 (previous row ± 15.625)
Etc., 7.8125, 3.90625, 1.953125, … Etc. (previous row ± bandwidth)

7.	  
Offsetting Digital Down 
Conversion (DDC) 
Frequencies
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In the following cases, hardware DDC cannot be used:

•	 IF bandwidth greater than 250 MHz

•	 IF center frequency outside the range of 375 to 625 MHz

•	 IF center frequency within 375 to 625 MHz, but the IF bandwidth causes part 
of the IF signal to fall outside the 375 to 625 MHz range

In those cases, software DDC is used exclusively. All decimation and frequency 
shifting is performed by the M9392A driver.

Digitizer only mode
In digitizer only mode, it is possible for any of the three operation modes 
described above to occur. Because the IF center frequency is now settable 
directly in the 89600 VSA software or via the M9392A API, it is much more likely 
for either the mixed mode DDC or software DDC modes to be used. The same 
rules from the previous section apply, but the IF offset hint is not needed to set 
the IF center frequency. All other settings will either utilize mixed mode DDC 
or software DDC, depending on whether the IF span is fully contained with the 
375-625 MHz range. Please also note the following:

•	 Streaming can operate only when the hardware is configured to use the 
hardware DDC mode.

•	 The 89600 VSA software is only used for playback of a recording. This means 
that the 89600 VSA software does not need to communicate with actual 
M9392A hardware. Simulated M9392A hardware will work just as well.

•	 IF (video) triggering only operates in pure hardware DDC mode. The M9392A 
driver will automatically switch to external trigger if video trigger is enabled 
and the digitizer is operating in mixed mode DDC or software DDC modes.

•	 The maximum acquisition time for a given bandwidth will be different in each 
of the three DDC modes.

•	 The nominal trigger delay may be different in each of the three DDC modes.
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8. 
Multichannel Streaming 
Demonstration Example

The M9392A SFP cannot be used to make multichannel streaming measurements.  
This demonstration example program has been created using Microsoft Visual 
Studio C# 2008®, to use the M9392A IVI COM to programmatically control a 
multichannel streaming session.

The demonstration example called MultiChannelStreamingExampleSolution is 
available with source code to allow engineers to begin making multichannel 
streaming measurements immediately. The source code shows which IVI COM 
command sequences are required and which test techniques are recommended. 
The solution can be built on a 32 bit operating system (OS) but a 64 bit OS is 
recommended.

Step 1. Download the example program
To get started, download the multichannel streaming example program. As this 
is a Microsoft Visual Studio C# 2008 solution, installed M9392A software must 
be version 1.2.0 or greater:1

•	 Go to www.agilent.com/find/M9392A and click on technical support.

•	 Access the drivers, updates and examples tab.

•	 Download MultichannelStreamingExample.zip, unzip and extract to your 
chosen folder

•	 A help file for the example can be found in <You Folder>/
MultiChannelStreamingExample/MCStreamingHelp.pdf

•	 Build and run <Your Folder>/MultiChannelStreamingExample/
MultiChannelStreamingExample.sln

1	 If you are running a different version of the software, you may need to replace the M9392A IVI 
reference in the example program and then rebuild the software program.
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After a few seconds the program GUI will appear.

Step 2. Configure the master and slave instruments
If you intend to run this program to control real hardware, you must first  
configure the master and slave instruments in the configuration store.

•	 Before you start, make sure you completed all software and hardware instal-
lation steps in the M9392A startup guide (http://cp.literature.agilent.com/
litweb/pdf/M9392-90001.pdf). The configuration includes two complete 
M9392A VSAs in the same chassis.

•	 Use Agilent Connection Expert (an Agilent IO libraries suite utility) to verify the 
VISA address and slot number of each module. Notice that the information in 
the right pane is relevant to the highlighted module in the left pane.

http://cp.literature.agilent.com/litweb/pdf/M9392-90001.pdf
http://cp.literature.agilent.com/litweb/pdf/M9392-90001.pdf
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•	 Use the M9392A Soft Front Panel (SFP) to create master and slave  
configurations.

•	 Open the M9392A SFP.

•	 In the connect to instrument dialog, highlight the modules you want to save 
as a master, and then click connect. This initializes the master modules and 
opens the SFP main window.

•	 Select File→Save Configuration.

•	 In the save instrument connection dialog, type in MasterVSA, make sure the 
checkbox for export to Agilent 89601 VSA is checked, and then click save. You 
have now saved the master configuration.

•	 Select File→Connect.

•	 In the connect to instrument dialog, notice your master configuration is 
named. Also notice the non-master modules are highlighted. These should 
be the slave modules. Make sure the modules you want to save as a slave 
are highlighted, and then click connect. This initializes the slave modules and 
opens the SFP main window.

•	 Select File→Save Configuration.

•	 In the save instrument connection dialog, type in SlaveVSA, make sure the 
checkbox for export to Agilent 89601 VSA is checked, and then click save. You 
have now saved the slave configuration.

Step 3. Cable the M9392A instruments for streaming
Add the appropriate cabling kit to the two existing cabled M9392A instruments 
to complete the dual-channel configuration. See the M9392A configuration 
guide http://cp.literature.agilent.com/litweb/pdf/5990-8254EN.pdf for details.

http://cp.literature.agilent.com/litweb/pdf/5990-8254EN.pdf
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Step 4. Touring the example program
Below is a screenshot from the multichannel steaming demonstration example 
software.
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Refer to the table below for usage information about the multichannel streaming 
example program. 

User interface item Purpose Description
Program menus Dropdown menus for File and Help

File menu Load Config – allows the user to load a previously saved 
measurement configuration. 
Save Config – allows the user to save a measurement 
configuration. 
Open DataViewer – opens Agilent’s free streaming data viewer. 
Exit – terminates the program.

Help menu M9392A System Information – displays the model, serial number, 
slot number, and the hardware revisions of all modules allocated 
to Ch1 resource and Ch2 resource (if two channels are selected). 
About – displays the current revision of the example program.

Change IVI 
resource

Change Resource – configures/re-configures the resources 
entered into Ch1 resource and Ch2 resource (if two channels are 
selected).

Select basic 
hardware type

M9392A VSA – provides automatic program control for one or 
two full M9392A instruments. 
M9202A + Other HW – provides automatic program control for 
one or two digitizer only M9392A instruments. In digitizer only 
mode, center frequency is set to 500 MHz and expected power is 
set to -4 dBm.

Select the number 
of channels

Single Channel – selects the IVI resource on Ch1 resource input 
and instantiates a driver session. 
2 Channel – selects the IVI resources in Ch1 resource and Ch2 
resource and instantiates a driver session on each IVI resource.

Select final 
storage

RAID – establishes connection to a viable RAID system. Since 
data can be written to RAID as fast as it is acquired, less RAM 
resources are required. 
Single HD – establishes connection to a single hard disk drive. 
This means for wide bandwidth captures for more than a few 
seconds large amounts of RAM will be required. Selecting Single 
HD allows all the free RAM to be allocated to the streaming 
process.
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User interface item Purpose Description
Start, acquisition. In the executable only version of the code these three buttons 

are on a different thread so that the GUI remains active over long 
recordings. 
Start – starts an acquisition based on the measurement 
configuration you have set in the GUI.

Configure 
simulation mode

The program will always start in simulation mode, basically 
guaranteeing the program will not crash due to bad IVI hardware 
configuration. 
Simulate – allows you to use the example program to make 
simulated acquisitions without having any hardware connected.

IVI hardware 
configurations

Ch1 Resource – is the IVI configuration used by real hardware 
configured as the master channel.
Ch2 Resource – is the IVI configuration used by real hardware 
configured as the slave channel.
If only one channel is selected, Ch2 will not be used.

Set streaming file 
names

Channel 1 File Out – sets the destination of the output streaming 
file on Ch1.
Channel 2 File Out – sets the destination of the output streaming 
file on Ch2.

Select or browse 
or select a 
streaming file

Use the Select buttons to browse for previous file names, find 
new drives, or create new file destinations.
It is possible to store each stream on a different volume. This is 
required when employing a dual controller JMR RAID system.

Current RAM 
required

Current RAM (MB) Required – estimates the RAM required 
based on the current configuration settings. If RAM required is 
greater than Free RAM, then a streaming record cannot be made.

Current free space 
on storage medium

Ch1 Storage (GB) – uses Windows® to calculate the free space 
on the allocated drive volume. If the space required for the 
current settings exceeds the available space the green box () will 
turn red () and the program will not allow a streaming record to 
be made. 
Ch2 Storage (GB) – uses Windows to calculate the free space on 
the allocated drive volume. If the space required for the current 
settings exceeds the available space the green box () will turn red 
() and the program will not allow a streaming record to be made.
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User interface item Purpose Description
Free system RAM Free RAM (MB) – indicates the amount of free RAM available 

for streaming acquisition. If current RAM required is larger than 
free RAM (MB), then the green box (▄) will turn red (▄) and the 
program will not allow a streaming record to be made.

Trigger slope Slope Pos – sets the trigger slope to positive.
Slope Neg – sets the trigger slope to negative.

Trigger level Trigger Level – sets the trigger level for digitizer on Ch1 (the 
master).
If video trigger is selected, then the units are in dBm.
If external trigger is selected, then the units are in volts.

Pre-trigger delay Pre-Trigger Delay (s) – sets the pre-trigger delay on each 
digitizer. If two channels are selected, pre-trigger will be applied 
to both channels. Pre-trigger can be no more than 75% of the 
current acquisition time. If acquisition time is 10 seconds and pre-
trigger is set to 2 seconds, the total recording will be 10 seconds 
long. The first 2 seconds of the data will be pre-trigger data. Note, 
pre-trigger is wholly dependent on the amount of system RAM.

Trigger timeout Trigger Timeout (ms) – sets the amount of time an active 
streaming acquisition will wait for a trigger before terminating.

Slave trigger level 
(two channels 
only)

Slave Trigger Level (V) – Only applies when two channels are 
selected. Sets the level of the trigger received from the master 
trigger out.

If in external trigger mode on the master digitizer (Ch1), the 
master trigger out does not need to be connected to the master 
trig 1 input. In external trigger mode the trigger out of the master 
must be connected to the slave digitizer trig 1 input.

For external trigger on master with two channels, set this value to 
between -0.5 V and -0.25 V.

If in video trigger mode on the master digitizer (Ch1), the master 
trigger out must be connected to both master trig 1 input and 
slave trig 1 input. Set the slave voltage somewhere between  
-0.5 V and -0.25 V.
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User interface item Purpose Description
Trigger mode External (Volts) – sets the trigger on the master digitizer (Ch1) to 

external.
Video (dBm) – sets the trigger on the master digitizer (Ch1) to 
video
Immediate – triggers a streaming acquisition as soon as the 
hardware is ready. Note, only valid for single-channel mode.
If two channels are selected, triggering will be defaulted to video 
trigger mode.

Serial port trigger Trigger – use this button to issue a serial port trigger at any time.
Serial Port Trigger – if selected, the master digitizer is set to 
external trigger mode. Pressing the trigger button will send a 
trigger voltage down a serial port cable between 0 V and 5 V.  
This feature is not available at this time.

Frequency Frequency MHz – sets the center frequency of the acquisition. 
If in multiple digitizer mode, this will set digitizer IF frequency 
(default 500 MHz).

Acquisition 
bandwidth

Bandwidth MHz – sets the cardinal sample rate appropriate to 
this bandwidth on both channels.
If bandwidth is set to 50 MHz, a sample rate of 62.5 MSa/s will 
be set. If bandwidth is set to 51 MHz, then the next highest 
cardinal sample rate is 125 MSa/s. For streaming the cardinal 
sample rates are 125 MSa/s, 62.5 MSa/s, 31.25 MSa/s, 15.625 
MSa/s. If the bandwidth requested * 1.25 falls between any two 
cardinal sample rates then the highest sample rate is selected.

Acquisition time Acquisition Time (s) – requested recording time for each 
channel.

Expected power Expected Power dBm – sets the gain in the M9392A front end so 
that the digitizer is always near full scale. For proper sensitivity, 
you should always try to provide an accurate value for expected 
power. Remember with signals that have a high peak-to-average 
ratio (PAR or power factor), this value should be added to the CW 
power output of the source. 
For example, for -10 dBm source output power with a modulated 
signal having PAR of 10 dB, expected power should be set to 
approximately 0 dBm.
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User interface item Purpose Description
Use preselector Use Preselector – turns on the M9360A preselector only if the 

M9392A instrument is set in highband (above 2.75 GHz) and 
bandwidth is set to 40 MHz or less.

Recording mode Useful only when two channels are selected.
Adjacent Channels – Full VSA instruments used this mode will 
set the slave channel center frequency to frequency MHz + 
bandwidth MHz, thus accommodating making adjacent channel 
measurements. Not currently supported in for digitizer only 
configurations using multiple digitizers.
Same Channel – sets both channels to the same center 
frequency (for full VSAs) or the same IF frequency (for digitizer 
only configurations using multiple digitizers).

Digitizer only 
mode

Digitizer Only Mode (debug) – allows support to debug front-end 
hardware independently of digitizers. This feature is not available 
at this time.

Progress bar Progress Bar – provides an accurate indicator of progress.
Will fill to 100% green after acquisition has completed. Note, 
when using simulated data, the actual simulated acquisition time 
can be different from the acquisition time set in the GUI.

Update status This window provides status information about the current 
configuration.
It updates approximately once per second during a streaming 
acquisition to provide the current status of the acquisition and 
display any API errors.

The demo program also has a basic time stamp feature that issues a Windows® 
system time event when a hardware trigger is detected by the M9392A software.  
The format is:

Trigger time: 6/12/2012 10:34:09.7590487

This simple time stamp is accurate to less than one second, but depends on the 
accuracy of the PC clock.

Step 5. Leveraging the demonstration example source code
The source code for this program can be used as a basis for you to write your 
own control programs. This is a C# solution. If you have a copy of Visual 
Studio® or Visual Studio C# Express®, you can modify the program and run it. 
If this is not required and you have already installed Agilent M9392A software 
version 1.2.0.xxxx, then you can run the program executable from:

•	 <Your folder>/MultiChannelStreamingExample/
MultiChannelStreamingDemo/bin/<Your Processor>/Release/
MultiChannelStreamingDemo.exe

•	 <Your Processor> is either x64 or Itanium.

Note, this example program does not run well on a 32 bit OS. If you modify the 
source code, the example will not be supported by Agilent.
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This section addresses two primary tools for finding target data within large 
recordings:

•	 Agilent’s DataViewer, available with the M9392A

•	 X-COM Systems’ Spectro-X signal analysis software

The Agilent DataViewer installed with the M9392A software can be used to 
view files of any size and easily snip out small sections of a much larger file so 
that the signal can be analyzed more fully in the 89600 VSA software.

Please refer to the M9392A software installation package which contains  
extensive help information for the DataViewer.

Agilent DataViewer screenshot 

9. 
Viewing and Analyzing 
Streaming Data
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X-COM systems’ Spectro-X software
The Spectro-X software has been enabled to read native binary streaming format 
(N5110A). Like the DataViewer it can only read a single stream of data and it 
can load a file of any size. A smaller subset of the main file can be snipped out 
for further analysis in the 89600 VSA software.

Unlike the DataViewer, Spectro-X software performs sophisticated automated 
searches on extremely large data sets. When the search criteria is met, a  
tabulated list of matching signals along with their time location within the 
streaming file is conveniently presented to the user.

The Spectro-X software also provides a configurable spectrograph and a play-
back spectrum that allows the persistence time to change. This can be useful 
for finding and displaying transient interfering signals.
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In the previous graph, an unusual intermittent waveform was found. A time 
signature of the waveform was acquired using the custom waveform search tool 
and then the signature was used to find other instances of this waveform that 
correlated highly to the original signature. The search uses a time domain cor-
relation technique to find all the matching instances within the complete record.

A spectrograph of any one of these items can be displayed just by selecting the 
item from the list above. The automatic search capability also includes commonly 
used communications standards such as GSM, Edge, 802.11a/g and LTE Uplink.

A spectrograph showing the interfering 
waveform in green is shown centered at 
20 MHz from the frequency origin.
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The following APIs are documented with their respective products. The intent of 
this section is to give an overview of some of the highlights of functions needed 
for automating the multichannel streaming with the PXI VSA. The API is the 
only way to control multichannel streaming.

M9392A
The M9392A software is used to control the five PXI VSA modules. The M9392A 
API documentation contains examples and more details. This white paper will 
only cover the new commands required for control of hardware for multichannel 
streaming.

The following new commands are available for multichannel setups, documented  
in the M9392A API.

AGM9392_ATTR_CURRENT_TRIGGER_SOURCE_Attribute has two new settings. 
These should be used for the master digitizer when in IF magnitude or external 
trigger modes. The slave digitizer should be set to external trigger mode.

When setting up each acquisition, the slave module must be armed before the 
master digitizer is armed, so that when the master digitizer triggers, the slave 
module is ready to receive the trigger generated by the master digitizer.

AGM9392_VAL_HINT_TYPE_STREAMING_MAX_BUFFER_SIZE_IN_BYTES is 
a new value accessible in the hints menu that allows the user to set the upper 
limit for allocating buffer memory. It is critically important for multichannel 
streaming since each M9392A streaming session knows nothing of any other 
instantiated session. This means that if the engineer does not allocate a maxi-
mum number of bytes for the buffer, all of the free RAM could be used up during 
multichannel streaming by the first digitizer. Allocating an upper limit for the 
RAM buffer allows the engineer to share RAM resources for multiple digitizers. 
The multichannel streaming demonstration example program does this when 
two channels are selected.

10. 
API Programming 
Instructions
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IVI COM programming
The following code, shown as Microsoft Visual Studio C#® snippets, are 
intended to highlight sequences of programming required or recommended for 
supporting multiple channel streaming measurements.

When creating streaming records that will consume a large amount of available  
system RAM or disk space it is always a good idea to verify that enough 
resources are available before beginning an acquisition.

11. 
Appendix

//Recommended for finding Free System RAM
using System.Diagnostics.PerformanceData;
private double GetFreeMemoryMB()
{
	 System.Diagnostics.PerformanceCounter ramCounter 
= new System.Diagnostics.PerformanceCounter(“Memory”, 
“Available KBytes”); //Use default RAM counter

	 double _freeMemory = ramCounter.NextValue();
	
	 _freeMemory = _freeMemory / 1e3;

	 string FreeRam = Convert.ToString(_freeMemory);
	 FreeMemoryMBytesTextBox.Text = FreeRam;//Update 
FreeRAM textBox

	 return _freeMemory;
	 }

//Recommended for finding Free Disk Space

using System.IO;

private double GetFreeDiskSpace(string Letter)
	 {
		  double freeDiskSpace = 0;
		  try
		  {
		  System.IO.DriveInfo driveInfo = new 
		  System.IO.DriveInfo(Letter);
			   freeDiskSpace = driveInfo.TotalFreeSpace;
		  }
		  catch (Exception ex)
		  {
			   UpdateStatusTextBox.Text = ex.Message.
ToString();
		  }
		  return freeDiskSpace; // In Bytes
		  }
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This code creates a function for calculating the approximate RAM resources 
required for the proposed streaming acquisition. Minimal RAM resources are 
required with a RAID because the buffering load is light, as data is stored as 
quickly as it is acquired. However, pre-triggering always requires RAM even 
when a RAID drive is used.

When a RAID drive is not used, a larger RAM buffer is required because a single 
hard disk drive cannot store data faster than 100 MB/s. When pre-triggering is 
used, the value set is included in the acquisition time. However, the value set for 
pre-triggering relies on the allocation of the appropriate amount of RAM buffer 
(500 MB per second of capture at 100 MHz BW).

// Recommended
private double Calculate_Required_RAM(double dSampleRate, double dAcquisitionTime, 
double PreTrigger, int iNoOfChannels)
	 {
		  double dTotalMemReq = 0;
		  if (!UsesRAID)
		  {
			   dTotalMemReq = (500e6 + dSampleRate * 4 * dAcquisitionTime *  
iNoOfChannels);// add 500MB buffer
			   dTotalMemReq = dTotalMemReq / 1e6; //MB Required
		  }
		  else
		  {
			   if (bandwidth > 20e6)
			   {
			   dTotalMemReq = (500e6 + dSampleRate * 4 * iNoOfChannels) +  
(dSampleRate * 4 * iNoOfChannels * PreTrigger);// Add 500MB buffer / acquisition time 
not important for RAID
			   dTotalMemReq = dTotalMemReq / 1e6; //MB Required
		  }
		  else
		  {
			   dTotalMemReq = (250e6 + dSampleRate * 4 * iNoOfChannels) +  
(dSampleRate * 4 * iNoOfChannels * PreTrigger);// Add 250MB Buffer
			   dTotalMemReq = dTotalMemReq / 1e6; //MB Required
			   }
		  }
		  string sTotalMemReq = Convert.ToString  
		  (dTotalMemReq);
		  RAMRequiredTextBox.Text = sTotalMemReq; 
		  //update display
		  return dTotalMemReq;
	 }
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Since the M9392A SFP cannot configure a synchronized 2-channel stream, the 
IVI API must be used. The M9392A does not automatically configure multiple 
channels so coupling between channels needs to be configured in the IVI COM 
control program.

1. 	The only IVI coupling between the master digitizer and the slave digitizer 
is through the multichannel trigger synchronization, where one digitizer is 
configured as the master digitizer responsible for triggering an acquisition on 
itself and the slave digitizer.

2. 	Multichannnel trigger mode can only use video triggering or external trigger-
ing on the master. The slave digitizer is always set to external trigger mode 
because it is triggered from master trigger out.

3. 	The programmer must manage the free system RAM and ensure there is 
enough RAM available for each digitizer.

4. 	Since by definition, a slave digitizer can only be triggered from the master 
digitizer trigger out the engineer must ensure that streaming sessions always 
initiate streaming on the slave digitizer before the master.

The following code snippets will illustrate programming sequences that are 
required.

2-channel streaming code snippets

agDrvr1 = new Agilent.AgM9392.Interop.AgM9392(); // instantiate driver
agDrvr2 = new Agilent.AgM9392.Interop.AgM9392(); // instantiate driver
agDrvr1.Initialize(resourceDesc1, true, true, Options); // Initialize HW
agDrvr2.Initialize(resourceDesc2, true, true, Options); // Initialize HW
//Now Setup Frequency, Bandwidth Acquisition Time, Trigger Mode. Etc [Not Shown here]
//Now Setup Streaming mode and output files
agDrvr1.Streaming.AcquisitionMode = AgM9392StreamingAcquisitionModeEnum.
AgM9392StreamingAcquisitionModeDurationLimited;
agDrvr1.Streaming.FileFormat = AgM9392StreamingFileFormatEnum.
AgM9392StreamingFileFormatN5110A;
agDrvr1.Streaming.Filename = streamFile1;
agDrvr2.Streaming.AcquisitionMode = AgM9392StreamingAcquisitionModeEnum.
AgM9392StreamingAcquisitionModeDurationLimited;
agDrvr2.Streaming.FileFormat = AgM9392StreamingFileFormatEnum.
AgM9392StreamingFileFormatN5110A; agDrvr2.Streaming.Filename = streamFile2;
Multichannel Wideband Streaming with PXI M9392A
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// Allocate maximum RAM resources to each digitizer – Use 
GetFreeMemoryMB() Function to calculate FreeRAM_MB
dLockMemory = (FreeRAM_MB) / 2; //Set maximum RAM Buffer 
memory per Digitizer
dLockMemory = (uint)dLockMemory;//

try
{
			   agDrvr1.Acquisition.
Hints.Add (AgM9392HintTypeEnum.
AgM9392HintTypeStreamingMaxBufferSizeInBytes, (long)
(dLockMemory * 1e6)); // This Hint sets an upper limit on 
the RAM Buffer size –Master Digitizer
			   agDrvr2.Acquisition.
Hints.Add (AgM9392HintTypeEnum.
AgM9392HintTypeStreamingMaxBufferSizeInBytes, (long)
(dLockMemory * 1e6)); // This Hint sets an upper limit on 
the RAM Buffer size –Slave Digitizer
}
catch (Exception ex)
{
Err = ex.Message.ToString();
UpdateStatus.Text = Err; //Text Box or Scrolling Rich 
Text Box

}

// Setup Multichannel Master/Slave Trigger Mode
enum triggerSlope
{
POSITIVE = 
Agilent.AgM9392.Interop.AgM9392ExternalTriggerSlopeEnum.
AgM9392ExternalTriggerSlopePositive,
NEGATIVE = 
Agilent.AgM9392.Interop.AgM9392ExternalTriggerSlopeEnum.
AgM9392ExternalTriggerSlopeNegative,
}

enum triggerMode
{
Ext = 0,
Vid = 1,
Imm = 2,
}
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//External Trigger Example
if (triggerModeSet == Convert.ToInt16(triggerMode.Ext)) // External
	 {
	 agDrvr1.Trigger.Source = 
AgM9392TriggerSourceEnum.AgM9392TriggerSourceExternal;
	 agDrvr1.Trigger.Source = 
AgM9392TriggerSourceEnum.AgM9392TriggerSourceExternalSyncOut; //REQUIRED
	 agDrvr1.Trigger.External.Level = TriggerLevel;
		  agDrvr1.Trigger.External.Slope = 
AgM9392ExternalTriggerSlopeEnum.AgM9392ExternalTriggerSlopePositive;//
REQUIRED

	 if (NoOfChannels == 2)
		  {
		  agDrvr2.Trigger.Source = 
AgM9392TriggerSourceEnum.AgM9392TriggerSourceExternal;//REQUIRED
		  agDrvr2.Trigger.External.Level = SlaveTriggerLevel;//REQUIRED
		  agDrvr2.Trigger.External.Slope = 
AgM9392ExternalTriggerSlopeEnum.AgM9392ExternalTriggerSlopePositive;//
REQUIRED
		  }
		  bWaitForTrigger = true;
	 }

//Video Trigger Example
if (triggerModeSet == Convert.ToInt16(triggerMode.Vid)) // Vid
		  {
		  agDrvr1.Trigger.Source = 
AgM9392TriggerSourceEnum.AgM9392TriggerSourceVideo;
		  agDrvr1.Trigger.Source = 
AgM9392TriggerSourceEnum.AgM9392TriggerSourceVideoSyncOut;//REQUIRED
		  agDrvr1.Trigger.External.Level = SlaveTriggerLevel;//REQUIRED
		  agDrvr1.Trigger.External.Slope = 
AgM9392ExternalTriggerSlopeEnum.AgM9392ExternalTriggerSlopePositive;//
REQUIRED
		  agDrvr1.Trigger.Video.Level = TriggerLevel;//REQUIRED
		  agDrvr1.Trigger.Video.Slope = AgM9392VideoTriggerSlopeEnum.
AgM9392VideoTriggerSlopePositive;//REQUIRED

	 if (NoOfChannels == 2)
		  {
		  agDrvr2.Trigger.Source = 
AgM9392TriggerSourceEnum.AgM9392TriggerSourceExternal;//REQUIRED
		  agDrvr2.Trigger.External.Level = SlaveTriggerLevel;//REQUIRED
		  agDrvr2.Trigger.External.Slope = 
AgM9392ExternalTriggerSlopeEnum.AgM9392ExternalTriggerSlopePositive;//
REQUIRED
		  }

	 bWaitForTrigger = true;
}
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// Begin Streaming on 2 Channels
agDrvr2.Measurements.Initiate(); // required for streaming
UpdateStatus.Text = “Start Streaming on Slave!\n”;//Text Box or 
Scrolling Rich Text Box
agDrvr2.Streaming.Start(); // required for streaming Start Slave 
Digitizer First
UpdateStatus.Text = “Initiate Measurement on Master!\n”;//Text Box or 
Scrolling Rich Text Box

agDrvr1.Measurements.Initiate(); // required for streaming Initialize 
Master Digitizer Second
UpdateStatus.Text = “Start Streaming on Master!\n”; //Text Box or 
Scrolling Rich Text Box

agDrvr1.Streaming.Start(); // required for streaming

// Update Streaming status during Acquisition
// Useful Functions for Status update
private void CheckForTrigger()
	 {
	 string Error = null;

	 if (agDrvr1.Measurements.WaitForTrigger(timeOut) == 
AgM9392WaitStatusEnum.AgM9392WaitStatusComplete)
		  {
		  UpdateStatus.Text = “Trigger Received!\n”;//
		  bWaitForTrigger = false;
		  }
else if (agDrvr1.Measurements.WaitForTrigger(timeOut) == 
AgM9392WaitStatusEnum.AgM9392WaitStatusWaitExpired)
		  {
		  UpdateStatus.Text = “Trigger Timed Out!\n”; //Text Box or  
		  Scrolling Rich Text Box

		  bWaitForTrigger = false;

	 try
		  {
		  UpdateStatus.Text = “Aborting Channel 1 Measurement!\n”;//
		  agDrvr1.Measurements.Abort();
		  UpdateStatus.Text = “Aborting Channel 2 Measurement!\n”;//
		  agDrvr2.Measurements.Abort();
		  }
	 catch (Exception err)
		  {
		  Error = err.Message.ToString();
		  UpdateStatus.Text = Error; //Text Box or Scrolling Rich Text 
Box
		  }
	 }
}
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private void StreamingStatusUpdate()
	 {

	 int NoOfErrors = agDrvr1.Status.NumberOfErrors;
	 if (NoOfErrors > 0)
		  {
		  int errCode = 0;
		  string ErrorMessage = null;
		  agDrvr1.Utility.ErrorQuery(ref errCode, ref 
ErrorMessage);
		  string ErrorLine = null;
		  ErrorLine = “\nThere Was an Error! ErrorCode:”  
		  + errCode + “Error Message:” + ErrorMessage +  
		  “\n\n”;
		  Thread.Sleep(100);
		  UpdateStatus.Text = ErrorLine; //Text Box or 
Scrolling Rich Text Box
		  }

		  string sStatus = “Acquired” +  
		  agDrvr1.Streaming.SamplesAcquired.ToString() +  
		  “Samples,” + 
		  “Wrote” + agDrvr1.Streaming.SamplesWritten. 
		  ToString() + “Samples,” + 
		  “Buffer” + ((double) 
		  (agDrvr1.Streaming.SamplesWritten) /  
		  (agDrvr1.Streaming.SamplesRequested) * 100). 
		  ToString() + “% Full,” +
		  “Acquisition OverLoaded?” +  
		  agDrvr1.Measurements.DidAcquisitionOverload. 
		  ToString() + “\n”;
		
		  UpdateStatus.Text = sStatus; //Text Box or 
Scrolling Rich Text Box

		  }
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// Example of Streaming Status Update using useful functions
while (bWaitForTrigger)
	 {
	 UpdateStatus.Text = “Waiting For Trigger 1...\n”;//
Text Box or Scrolling Rich Text Box

	 CheckForTrigger();
	 }

	 string Error = null;

	 while (agDrvr1.Streaming.IsActive && !exit)
		  {
		  try
			   {
			   StreamingStatusUpdate();
			   }
		  catch (Exception err)
			   {
			   Error = err.Message.ToString();
			   UpdateStatis.Text = Error; //Text Box or  
			   Scrolling Rich Text Box

			   }
			   System.Threading.Thread.Sleep(1000); //  
			   update every second
		  }
		  UpdateStatus.Text = “Recording Complete\n”;// 
		  Text Box or Scrolling Rich Text Box
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